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1 Introduction

1.1 Product Description

CCPlay FilePro is a highly efficient post production software encoding
tool for MPEG-2 TS, H.264/MPEG-4 AVC TS, MXF XDCAM, MXF D10
(IMX), AS-02 bundles, GXF and MOV/MP4 video file formats. With CC-
Play FilePro, EEG’s CC expertise is now available for file-based workflow
environments.

This streamlined tool extends the functionality of EEG’s industry-standard
CCPlay software suite, which was previously available only on the HD485
HD/SD closed captioning encoder. Capable of performing caption encod-
ing at rates of 10X real-time or more, CCPlay FilePro brings maximum
post closed captioning efficiency, accuracy, reliability and intuitive oper-
ation to Windows®workstations.

Additional features and benefits of CCPlay FilePro from EEG include:

• No time-consuming re-encoding of video essence, and no genera-
tional loss

• Simple interface for scheduling and queuing any number of encod-
ing jobs

• Accepts all common closed captioning and subtitling file formats
including ECF, SCC, Timed Text, CAP, and many more

• Encodes a CableLabs®compliant stream with full CEA-608 and
CEA-708 data structures

• Recomputes stream timing data and all necessary headers for files
with or without pre-existing closed caption structures

• Configurable time code shift to solve sync-up between video file
and caption file time bases

• Performs AFD encoding into file-based video assets either simulta-
neous to closed caption encoding, or independently

• Can export caption files in the form of an Timed Text file, ECF file,
SCC file, AAF caption track suitable for import into Avid Media
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Composer 5 and MOV file with caption track suitable for import
into Final Cut Pro

• Standalone caption file format conversion

• Performs XDS packet insertion, such as V Chip and CGMS-A for
Copy and Redistribution

• Omneon integration for encoding of files located remotely on Om-
neon servers

• Batch processing for encoding video archives (Server only)

• Full automation using FilePro Server’s watch folder profiles (Server
only)

• Legalization of embedded captions (Server only)

• Re-timing of embedded captions (Server only)

• Command line application for scripting jobs (Server only)

For post production facilities working exclusively in the file-based do-
main, CCPlay FilePro insures an efficient closed captioning workflow
completed via the highest-quality specifications of EEG.

Copyright © EEG Enterprises, Inc. 2011–2016
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2 Getting Started

2.1 System Requirements

• Windows XP, Vista, Windows 7

• 1GB RAM, 2GB or more recommended

• Quicktime (for MOV or MP4 processing)

2.2 Installation

2.2.1 Windows Installer

A Windows installer file (.msi) will be provided via download or CD-ROM
after purchasing this software. Installation steps are as follows:

1. Double click the installer file to begin installation. You should see
the welcome screen as shown in Figure 1.

Figure 1: Installer Welcome Screen

2. ClickNext to continue with the installation. You should be brought
to the Choose Installation Folder screen as seen in Figure 2.

3. Choose an installation folder or leave the default folder selected
and then click Next to continue with the installation.

Copyright © EEG Enterprises, Inc. 2011–2016
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Figure 2: Installer Select Folder Screen

4. Click Next again to start the installation.

5. A prompt to enter credentials for the watch folder service will be
displayed before installation is complete, as shown below in Figure
3. If not licensed for FilePro Server simply select "Use the Default
Local System Account". If licensed for Server, choose a username
and password for the user account that has priviledge to access any
network shared drives that are desired for watch folder processing.
This setting can be modified later.

Figure 3: Set Service Login

6. Once the installation is complete click Close to close the installa-
tion window.

Once installation is complete, the application will be installed to the
folder chosen during the installation process. A Desktop shortcut and
Start Menu shortcut is created.
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2.2.2 CD-ROM

If you were provided with a CD-ROM you should insert it into the CD-
ROM drive of your PC. Navigate to the CD-ROM and double click the
Windows installer located on the disc. Follow the installation steps out-
lined in Section 2.2.1.

2.2.3 USB Dongle

CCPlay FilePro is licensed via a USB dongle. The dongle should’ve been
provided with your software. Insert the supplied dongle into a USB port
on the computer. This is required for operation of CCPlay FilePro.

Copyright © EEG Enterprises, Inc. 2011–2016
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3 CCPlay FilePro Operation

3.1 Workflow

CCPlay FilePro is a tool that will encode data from an existing caption
data file into a video file. The tool is also capable of legalizing/re-timing
captions already embedded in a video file (Server only). The output
is a video file of the same format with both 608 and 708 captions in-
cluded (when applicable). This file is then suitable for ingest or playout
using any system that supports SMPTE standards for preservation of
file-based closed captioning and ancillary data. CCPlay FilePro is also
capable of converting caption files to different formats and extracting
embedded captions from video files to various caption file formats.

3.2 Supported Video File Types

MPEG-2

MPEG-2 files are valid for encoding with this tool. MPEG-2 video streams
should be comprised of a Transport Stream that contains a single video
elementary stream and one or more audio streams. CCPlay FilePro pro-
duces MPEG-2 files that are CableLabs compliant. Most CableLabs com-
pliance errors in the input file will be fixed, such as broken PCR’s, packet
counter discontinuity, misaligned PES packet starts, and many more.

H.264/MPEG-4 AVC

AVC (H.264/MPEG-4) streams in a Transport Stream are valid for encod-
ing with this tool. CCPlay FilePro will produce a CableLabs compliant
output Transport Stream.

MXF

MXF files that are self-contained and conform to Operational Pattern
1a, such as XDCAM and Omneon OP1a (internal) files, are valid for
encoding with this tool. The MXF files can use any video codec (MPEG-2,
D-10/IMX, DVCPro, AVC-Intra, etc.) because CCPlay FilePro encodes the
closed captions and other data into a separate SMPTE 436M Ancillary
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Data Track. CCPlay FilePro can also encode captions into the custom
track used by legacy Quantel products for this purpose.

AS-02 Bundle

AS-02 bundles are valid for encoding with this tool. If the AS-02 bundle
already has an essence component file with a SMPTE 436M Ancillay
Data Track, then CCPlay FilePro will encode the closed captions and
other data directly into this essence component file. Otherwise, CCPlay
FilePro will create a new essence component file with a SMPTE 436M
Ancillary Data Track and add it to the bundle.

GXF

General Exchange Format-2 (GXF) is supported for encoding with FilePro.
Captions, XDS and AFD will be encoded in embedded ancillary media
packets within this format.

MOV/MP4 Quicktime

FilePro supports the embedding of caption tracks in MOV/MP4 Quick-
time formatted files. The user has the option to embed for iOS/iTunes/Quicktime
support or Final Cut Pro import.

FilePro Server users also have the ability to create a caption track using
SEI User Data captions embedded in the video track.

Copyright © EEG Enterprises, Inc. 2011–2016
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3.3 Supported Input Caption File Types

The following caption file types are supported for encoding:

• Basic Subtitle (.txt)

• Captions, Inc. (.cin)

• Cheetah 2.2 (.cap)

• Cheetah ASCII (.asc)

• CPC DOS (.cpc)

• CPC WIN CapMaker Plus (.cap)

• EEG Caption File (.ecf)

• EEG Simple or "Dot Number" Files (.0, .1, .2, ...)

• NCI (.ted, .cap, .flc)

• Scenarist (.scc)

• SoftNI (.sub)

• Softitler (.txt)

• SubRip (.srt)

• Vitac VCAPS (.vcc, .vci, .vcp)

• WGBH - NCAM (.tds)

Basic Subtitle formats are files conforming to the following conventions:

1. ASCII time codes.

2. Time code format is HH:MM:SS:FF or HH:MM:SS.FF.

3. No non-printing characters found in a record between time code
and caption text.

4. Windows Latin 1 character set encoding. DOS character set not
supported.

Copyright © EEG Enterprises, Inc. 2011–2016
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3.4 Supported Output Caption File Types

• Advanced Authoring Format (.aaf)

• EEG Caption File (.ecf)

• MOV Quicktime File w/ Caption Track (.mov)

• Scenarist (.scc)

• SAMI File (.smi)

• SubRip File .srt

• SMPTE Timed Text (.xml)

Copyright © EEG Enterprises, Inc. 2011–2016
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3.5 Starting Application

The CCPlay FilePro application can be started by double clicking the
Desktop shortcut or the Start Menu shortcut, found in the EEG folder.

3.6 Main Window

The main window of the CCPlay FilePro application is displayed in Fig-
ure 4. The menu is located at the top of the window and will be discussed
in more detail in Section 3.6.1. The left panel of the application is the
File Queue panel and will be where video files are queued for encod-
ing. The File Queue will be further explained in Section 3.6.2. The right
panel of the application is for File Encoding Settings. A description of
these settings will be presented in Section 3.7.

Figure 4: Main Window

Copyright © EEG Enterprises, Inc. 2011–2016
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3.6.1 Menu

File Menu

• Add File(s) Add a file or group of files to the encoding queue. Files
of unsupported types will not be added.

• Add Folder Add an entire folder to the encoding queue. Files of
unsupported types will not be added.

• Add Batch Job Adds a batch job to the encoding queue.

• Exit Exit the application.

Figure 5: File Menu

Queue Menu

• Start Encoding Starts encoding the file selected in the File Queue.

• Open File in Player Opens the encoded file in its associated ex-
ternal player (if the file exists).

• Open Output Folder Opens the output folder. This folder is set in
the Preferences as described in Section 3.12.

• Cancel Cancels encoding of the currently selected file in the File
Queue.

• Remove Removes the currently selected file from the File Queue.

• Remove All Removes all of the files in the File Queue.

• Clear Finished Clears any files in the file queue that are finished,
cancelled or failed.

Copyright © EEG Enterprises, Inc. 2011–2016
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Figure 6: Queue Menu

Mode Menu

• Normal Normal encoding mode.

• Omneon Omneon server remote file encoding mode.

Tools Menu

• Preferences Opens the Preferences window.

Help Menu

• About Opens the About window.

Copyright © EEG Enterprises, Inc. 2011–2016
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3.6.2 File Queue

The File Queue is located on the left side of the Main Window. Files
can be added here by going to File->Add File(s) or File->Add Folder.
Files can also be dragged and dropped onto the queue. Files of unsup-
ported types will not be added to the queue, and an error message will
be displayed.

Once added to the queue, the File Encoder Settings should be set, as
described in Section 3.7. Operations such as Start Encoding, Cancel
File, Remove File, Open Output Folder and more can be accessed by
right clicking a file in the queue, or by using the the Queue Menu as
explained in Section 3.6.1.

Each row in the File Queue contains 2 columns: The first column for
the input file name and the second column for the current status of the
file. Files can have the following status:

• Not Started Encoding has not been started for this file.

• Queued Encoding has been started by clicking Start Encoding
with the file selected and it has been added to the end of the queue.
It will be encoded after all encoding jobs ahead of it have com-
pleted.

• Percentage xx% The file is encoding and the percentage repre-
sents the encoding progress.

• Finished The file successfully finished encoding.

• Failed The file failed to finish encoding.

• Cancelled Encoding of the file was cancelled by the user.

Files will remain in the queue until they are removed or the application
exits. Files can be cancelled and/or removed one by one, or they can all
be removed at once. Finished files (finished, cancelled, failed) can be
cleared by clicking Remove Finished from the right-click menu or the
Queue Menu.

Copyright © EEG Enterprises, Inc. 2011–2016
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3.6.3 Encode Settings

Encode Settings will be discussed in detail in 3.7.

3.6.4 File Info

Upon adding or selecting a file in the File Queue corresponding file in-
formation will be displayed as shown in Figure 7. Most fields are only
applicable to video files.

Figure 7: File Info

Full Path

The full path to the input file in the queue.

Quality

Specifies the video quality, SD or HD.

Video Bit Rate

Bit rate of the video stream.

Transport Rate

Bit rate of the MPEG-2 transport stream (only applicable for MPEG-2
and MPEG-2/H.264 AVC files).

Frame Rate

Video frame rate in frames per second (fps).

Timecode

Indicates the presence of embedded video timecode (GOP timecode for
MPEG-2).

Copyright © EEG Enterprises, Inc. 2011–2016
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Initial Timecode

Indicates the initial embedded video timecode, if any. Useful when deter-
mining if captions to be encoded must be shifted forward or backward.

VANC/UD Present

Indicates the presence of VANC or user data in the video file. This does
not necessarily indicate the presence of fully formed caption data.

Drop Frame

Specifies the drop frame timing of the video file.

AFD

Indicates presence of AFD in the video file.

AFD Code

Indicates the embedded AFD code, if any.

Copyright © EEG Enterprises, Inc. 2011–2016
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3.7 Video File Encoder Settings

3.7.1 Captions

Figure 8: Caption Settings Tab

Input Caption File

A caption file should be selected for each encode job, as shown in Figure
9. Supported input caption file types are listed in Section 3.3.

Figure 9: Language 1 Input File Selection

Timecode Shift

A Timecode Shift can be used if the encoded captions are not lining up
with the video, or if there is a known timecode offset in the caption file.

Copyright © EEG Enterprises, Inc. 2011–2016
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Select the shift increment from the SMPTE timecode selector shown
in Figure 10. Choose Shift Forward if the captions should be shifted
forward by the selected increment, and choose Shift Backward if they
should be shifted backwards.

The checkbox labeled Flip Drop Frame can be used to flip the drop
frame timing of the caption. When selected, the drop frame timing of the
captions being encoded (or already present in the video) will be flipped
from drop frame to non-drop frame timing, or vice versa.

Figure 10: Timecode Shift

Output Caption File

An optional output caption file can be selected for each encode job, as
shown in Figure 11. Just choose an output type from the pull-down
menu. Supported output caption file types are listed in Section 3.4.

Figure 11: Language 1 Output File Selection
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3.7.2 AFD

Select an AFD code from the drop down menu shown in Figure 12 to
insert AFD into the video stream.

Figure 12: AFD Settings Tab
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3.7.3 XDS

Use this tab to add XDS packets to video stream.

Figure 13: XDS Settings Tab

Copy and Redistribution

To insert CGMS-A or APS you must check "Enable Packet" as seen in
Figure 14. Then select a CGMS-A code and/or APS code. The drop down
menus also display the associated bit patterns for the code options.

Figure 14: Copy and Redistribution

V-Chip

To insert V-Chip packets, select a program rating from the dropdown box
as shown in Figure 15 below. Some selections will also allow the setting
of auxiliary rating bits such as Violence, Sex, Language and Dialogue.

Copyright © EEG Enterprises, Inc. 2011–2016
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Figure 15: V-Chip

3.7.4 DVS

Select a WAV file with descriptive video services (DVS) as shown in Fig-
ure 16 to insert DVS into the video.

Figure 16: DVS Settings Tab

3.7.5 Post Encode

Use this tab to modify the post-encode file action. The Output Folder
can be changed, as shown below in Figure 17. An Output filename
suffix can be entered here or left blank if desired. The user can force
the creation of sub-folders for each job by selecting Create separate
sub-folder for output files. The user can also turn on/off the human
readable caption logs by selecting Create CC logs (.s1/.s2).

Copyright © EEG Enterprises, Inc. 2011–2016
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Figure 17: Post Encode Settings Tab

3.7.6 Advanced Settings

Use this tab to modify any advanced settings. Advanced settings include
Advanced MXF Settings, Advanced Timed Text Settings, Upstream
Services and Quicktime/MP4 Settings.

Advanced MXF Settings allows the user to select the location for MXF
caption insertion. Options include Default, SMPTE 436M Ancillary Data
and TrackQuantel Closed Caption Data Track.

Advanced Timed Text Settings allows the user to select Timed Text
export options such as timecode formatting and inclusion of 608 tunnel-
ing data.

Upstream Services provides a mechanism for blocking upstream ser-
vices such as service 1 captions, service 1 text, services 2 captions, ser-
vice 2 text and XDS.

Quicktime/MP4 Settings allows the user to select the inserted caption
format based on the target application. The options are iOS/iTunes/Quicktime
and Final Cut Pro.

Copyright © EEG Enterprises, Inc. 2011–2016
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Figure 18: Advanced Settings Tab

3.8 Encoding Video Files

3.8.1 Normal Mode Encoding

Closed captions, AFD and XDS can be encoded into a video file using
CCPlay FilePro. To encode this metadata into a video file:

1. Add the video file to the File Queue

2. Set the encode properties such as input caption file, AFD and XDS
code as described in Section 3.7

3. Start the encoding job by clicking Start Encoding

Encoding jobs can be cancelled at any time.

Note: FilePro Server users can legalize video files with embedded cap-
tions by omitting the input caption file(s). FilePro Server users can also
re-time video files with embedded captions by omitting the input caption
file(s) and adding a timecode shift (or flip drop frame).

Copyright © EEG Enterprises, Inc. 2011–2016
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3.8.2 Omneon Mode Encoding

In order to encode captions into an MXF file on a remote Omneon server
the user must first select textbfMode->Omneon from the drop down
menu. Once the remote file is selected, just follow the instructions in
the previous Section 3.8.1 to start an encode job.

3.9 Recording Captions

Captions can be extracted from a video file and output into any of the
output file caption types listed in 3.4.

To initiate a caption record:

• Add a video file to the File Queue

• Select an output caption file type and destination

• Start the recording job by clicking Start Encoding

Note: A timecode shift can be applied to a recorded caption file.

Copyright © EEG Enterprises, Inc. 2011–2016
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3.10 Converting Caption Files

In addition to video file encoding, CCPlay FilePro can also convert any
of the caption file formats listed in Section 3.3 to any of the caption file
formats listed in Section 3.4.

To convert a caption file to a different format:

1. Add the caption file to the File Queue

2. Choose the output caption file format

3. Start the conversion job by clicking Start Encoding

3.11 Output Files

All CCPlay FilePro encode processes will output the following files:

1. CableLabs compliant MPEG-2 video file or MXF video file, with
inserted captions and/or AFD code

2. Service 1 caption text log

3. Service 1 caption file (Optional)

Caption text logs and caption files are only created when applicable (i.e.
there are captions present in source file or captions are being inserted).

If a failure is encountered in parsing/encoding an input file then a failure
file will also be created, in addition to the files mentioned above. The
output files will be discussed in more detail in the following sections.

3.11.1 Video File

An output video file will be created in the output directory, which can be
assigned as described in Section 3.12. The output file will have the nam-
ing convention "inputfilename_EEG.extension" by default. The output
filename prefix is configurable per job and the default can be changed
in the Preferences.

Copyright © EEG Enterprises, Inc. 2011–2016
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3.11.2 Caption Text Log

A closed caption text log is created for Service 1 and 2 captions. This file
provides a timestamped, human-readable text formatted version of the
captions encoded/extracted. The naming convention for this file is "in-
putfilename_EEG.s1". This file will only be created if there are captions
present in the source file or captions are being inserted from a file.

3.11.3 Caption File (Optional)

A caption file format may be selected as an additional output. Supported
caption output file types are listed in 3.4.

3.11.4 Failure File

A failure file is created in the event that a given file cannot be success-
fully encoded. This could indicate an invalid Transport Stream in the
video file (MPEG-2), a broken file, or other processing errors. The fail-
ure file will have the filename format of "inputfilename_EEG.failure". All
files from failed jobs will be placed in a "Failed" sub-folder of the output
folder.

In the event of an unexpected failure, you may email the EEG support
team (support@eegent.com), attaching the failure file for reference. You
may be provided with instructions for uploading the full video file to a
secure server for further analysis.
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3.12 Preferences

Figure 19: Preferences Window

The Preferenceswindow can be accessed by going to Tools->Preferences.
The following Application Settings can be changed here:

• Output Folder The folder where the output files are placed. Out-
put files are explained in Section 3.11.

• Output filename suffix The suffix to append to the output file-
names (i.e. _EEG). This field can be left blank.

• Create separate sub-folder for output files If selected the out-
put files for each job will be placed in a new sub-folder within the
main Output Folder.

• Create CC logs (.s1/.s2) If selected each job will output human
readable caption logs as described in Section 3.11.2.
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Watch Folder Settings can also be changed from the Preferences win-
dow. However, Watch Folders and Profiles are only applicable for FilePro
Server users. FilePro Server settings and Watch Folder configurations
are discussed in detail in Section 5.

3.13 Performance

CCPlay FilePro encodes at a rate of 10 times realtime performance or
more for HD files and much quicker for SD files. Performance may vary
based on several factors such as the processor speed, available RAM,
disk I/O latency and the compression level of the files. The performance
figures stated in this section are intended to be used as a guideline for
estimating encoding throughput.
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4 CCPlay FilePro CR (caption record only)

4.1 Overview

CCPlay FilePro CR is a stripped down version of FilePro. It shares the
same user interface however, caption recording and conversion are the
only features enabled. FilePro CR allows the user to add a video or cap-
tion file to the queue and then select an output caption file. All other
encoding features will be grayed out and inaccessible. If you have a
copy of FilePro CR and wish to utilize the wide range of encoding fea-
tures, please contact our Sales team (sales@eegent.com) for purchase
information.

Copyright © EEG Enterprises, Inc. 2011–2016



31 CCPlay FilePro

5 CCPlay FilePro Server

5.1 Overview

CCPlay FilePro Server is a watch folder extension to the standard FilePro
application. Watch folders can be configured using the FilePro applica-
tion preferences. FilePro operations such as caption encoding, caption
extraction and caption file conversion can be carried out by dropping
corresponding files into the pre-configured watch folders. The following
sections will explain watch folder configuration in detail.
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5.2 Watch Profiles

Watch folders can be configured via the Preferences window in the FilePro
application which can be accessed by selecting Tools->Preferences.
To setup a watch folder a Watch Profile must be created. To add or re-
move a Watch Profile click the "+" or "-" in the lower right hand corner
of the Watch Folders box. Upon clicking "+" an "Add Watch Folder"
dialog will appear as seen in Figure 20. Enter a name for the new Watch
Profile and click "OK".

Figure 20: Add Watch Folder
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5.3 Watch Settings

Figure 21: Watch Settings

5.3.1 Job Type

Upon creation of a new Watch Profile it must be configured based on the
user’s intended operation (i.e. Job Type) for these folders. Three differ-
ent Job Types can be selected: Video Encode, Video CC Extraction,
Video Legalization, Video Re-Time and CC File Conversion.

The Video Encode Job Type should be selected if caption encoding is de-
sired. The Video CC Extraction Job Type should be selected if caption
extraction to file is desired. Video Legalization should be used for le-
galizating a file with embedded captions. Video Re-Time can be used to
re-time or shift the timing of a file with embedded captions. The Caption
File Conversion Job Type should be selected if caption file conversion is
desired.

5.3.2 Mode

The Mode settings refer to the operational mode of encoding. Normal
mode should be used in most cases. If in-place encoding of video files
directly on an Omneon server is desired then Omneon mode should be
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selected. Note that the only Job Type available in Omneon mode is Video
Encode.

5.3.3 Output Caption File Format

Select an output caption file to be created with each Video Encode, Video
CC Extraction or CC File Conversion job, or leave as "None".

5.3.4 Watch Folder

Select an Input Caption File Watch Folder and Input Video File
Watch Folder (when applicable). Corresponding files will be dropped
in these folders to trigger jobs. These folders can be the same.

5.4 Encode Settings

Figure 22: Encode Settings

5.4.1 Timecode Shift

Select a forward or backward time shift for captions being encoded,
and/or flip drop-frame timing.
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5.4.2 AFD

Select an Active Format to encode in the video file.

5.4.3 XDS

Select XDS messages to encode in the video file.
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5.5 Post Encode Actions

Figure 23: Post Encode Settings

5.5.1 Output Files

Output Folder This folder is the destination for any output files.

Output filename suffix This suffix will be appended to the end of any
output filename, before the file extension, in order to differentiate the
output files from input files. The default value is "_EEG" but any string
can be entered here.

Separate output folders for each job in output folder With this op-
tion selected the output video file with stitched captions, along with the
output caption file (if selected) and any log files will be put in a separate
folder in the output folder. This option can be used to keep the output
folder organized and easier to maintain.

5.5.2 Input Caption File

There are 4 post-encode options for the input caption file:

• Move to output folder Move the input caption file to the output
folder
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• Move to: Move the input caption file to a custom folder which
must be assigned

• Add suffix: Add an assignable suffix to the input caption filename

• No action Leave the input caption file in place

5.5.3 Input Video File

There are 4 post-encode options for the input video file:

• Move to output folder Move the input video file to the output
folder

• Move to: Move the input video file to a custom folder which must
be assigned

• Add suffix: Add an assignable suffix to the input video filename

• No action Leave the input video file in place

5.6 Advanced Settings

Use this tab to modify any advanced settings. Advanced settings include
Advanced MXF Settings, Advanced Timed Text Settings, Upstream
Services and Quicktime/MP4 Settings.

Advanced MXF Settings allows the user to select the location for MXF
caption insertion. Options include Default, SMPTE 436M Ancillary Data
and TrackQuantel Closed Caption Data Track.

Advanced Timed Text Settings allows the user to select Timed Text
export options such as timecode formatting and inclusion of 608 tunnel-
ing data.

Upstream Services provides a mechanism for blocking upstream ser-
vices such as service 1 captions, service 1 text, services 2 captions, ser-
vice 2 text and XDS.

Quicktime/MP4 Settings allows the user to select the inserted caption
format based on the target application. The options are iOS/iTunes/Quicktime
and Final Cut Pro.
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Figure 24: Advanced Settings

5.7 Operation

Once Watch Profiles are configured, jobs such as Video Encode, Video
CC Extraction and Caption File Conversion can easily be automated. Ini-
tiating a Video Encode job is accomplished by dropping a video file into
the Input Video File Watch Folder and corresponding caption file with
the same file prefix (i.e. test.mpg and test.scc) into the Input Caption
File Watch Folder (assuming the folder’s Job Type is Video Encode).
This will automatically trigger a caption encode job. Upon completion
of the encode job the output files can be found in the specified output
watch folder (or in a separate folder inside that folder if the separate
output folder option is selected). The original video and caption files
will be moved to this directory as well.

In the case of a Video CC Extraction job, the video file can be dropped
in the Input Video File Watch Folder. Upon completion of the job the
output caption file and log files will be placed in the output watch folder.

For a Caption File Conversion job, the caption file can be dropped in
the Input Caption File Watch Folder. The output caption file will be
created in the output watch folder.

In all cases, the Post-Encode Actions (as defined in Sections 5.5.2 and
5.5.3) will be applied to the input files.
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